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Introduction

Welcome to OS X Mavericks on Demand, a visual quick refer-
ence book that shows you how to work efficiently with Apple
OS X Mavericks.  This book provides complete coverage of
basic to advanced OS X skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in OS X Mavericks, just
look for the icon: New!. The new icon appears in the table of
contents and throughout this book so you can quickly and
easily identify a new or improved feature in Mavericks. A
complete description of each new feature appears in the New
Features guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
A+P, as a quicker alternative to using the mouse. A complete
list of keyboard shortcuts is available on the web at 
www.queondemand.com or www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Get More on the Web

http://www.queondemand.com
http://www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the web at 
www.queondemand.com or
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

http://www.queondemand.com
http://www.perspection.com


The Workshops
walks you
through in-depth
projects to help
you put the OS X
Mavericks to
work.

Introduction xix

Additional
content
is available
on the web.

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshops. You start each
project with a sample file, work
through the steps, and then com-
pare your results with project
results file at the end. The Work-
shop projects and associated files
are available on the web at  
www.queondemand.com
orwww.perspection.com.

Get More on the Web
In addition to the information in
this book, you can also get more
information on the web to help
you get up to speed faster with
OS X. Some of the information
includes:

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

http://www.queondemand.com
http://www.perspection.com
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More Content
◆ Photographs. Download

photographs and other
graphics to use in your
documents.

◆ More Content. Download
new content developed after
publication.

You can access these additional
resources on the web at 
www.queondemand.com or
www.perspection.com.

Download and
use Photographs
to help you add
impact to your
documents.

http://www.queondemand.com
http://www.perspection.com


Finding What You Want with
Spotlight

Introduction

If you’re looking for specific content on your computer or net-
work and you don’t know where to find it, you can use
Spotlight to help you locate it. Spotlight not only searches
the names of your files and folders, it also searches their con-
tent. In addition, Spotlight searches other information stored
in files, known as metadata, which describes how and when
and by whom a particular set of data was collected, or how
the data is formatted. Examples of metadata include authors,
page size, creation and modification dates, duration of music
and movies, dimensions of graphics or PDF documents,
exposure time of a camera lens for photographs, and names
of layers in Photoshop.

Spotlight is conveniently located on the right side of the
menu bar on your Mac screen. You can identify Spotlight by
the blue icon with a magnifying glass. Spotlight performs a
live search of your Home folder on your computer using the
information you know. As you type in Spotlight, a menu
appears displaying a list of everything Spotlight can find to
match what you’ve typed so far. As you continue to type, the
list changes. Spotlight searches for everything on your com-
puter that matches what you’ve typed, which includes every
file, folder, program, e-mail message, address book entry,
calendar appointment, picture, movie, PDF document, music
file, web bookmark, Microsoft Office document, and System
Preferences panel, and lists the 20 best matches divided into
categories, which you can customize later. 

When you start OS X for the first time, Spotlight automat-
ically starts collecting search information about your Home
folder, known as indexing. The indexing process initially takes
about 15 to 30 minutes to perform (the Spotlight icon pulses)
and then updates take place as needed. Indexing the infor-
mation on your computer reduces the time it takes to per-
form a search.

3

3
What You’ll Do

Find Information Using Spotlight

Find Information in the Spotlight
Window

Filter Spotlight Results

Group and Sort Spotlight Results

Work with Spotlight Results

Set Spotlight Preferences

Search for Files Using the Find Window

Search for Hard to Find Information

Work with Find Window Results

Create and Use Smart Folders 

Get Help While You Work

Get Help Using Spotlight

57



If you’re looking for specific content on your computer and you don’t
know where to find it, you can use Spotlight to help you find it. Even if
you can only remember part of the content. Spotlight performs a live
search of your Home folder on your computer using the information you
know. As you type in Spotlight, a menu appears displaying a list of
everything Spotlight can find to match what you’ve typed so far. As you
continue to type, the list changes. If you type two words, Spotlight finds
items that contain both words. Spotlight searches for everything on your
computer that matches what you’ve typed, which includes every file,
folder, program, e-mail message, address book entry, calendar appoint-
ment, to-do item, picture, movie, PDF document, music file, web book-
mark, document, and System Preferences panel, and lists the 20 best
matches divided into categories, which you can customize later.
Spotlight not only searches the names of your files and folders, it also
searches their content, and displays a preview of the material from the
menu. In addition, you can drag items from the Spotlight menu for use in
folder or on the desktop. You can search by typing phrases or metadata
attributes, and using boolean operators.

58 Chapter 3

Finding Information
Using Spotlight

Find Information Using Spotlight

Click the Spotlight (magnifying-
glass) icon on the menu bar.

TIMESAVER Press A+Space
bar to open Spotlight. 

In the Spotlight field, type what
you want to find. To find a specific
phrase, place quotes around it. 

As you type, a menu begins to
display a list of everything
Spotlight can find to match what
you’ve typed so far. As you
continue to type, the list changes.

To preview an item, point to the
item in the list.

TIMESAVER Press and hold
A to display more information. 

To copy an item, drag the item off
the Spotlight list.

To open an item, click the item or
use the arrow keys to scroll down
the list, and then press Return.

To clear or stop a search, click the
Close button (x) in the Spotlight
field.

6

5

4

3

2

1
12

6

5

3Preview of search item

4Wikipedia



Chapter 3 Finding What You Want with Spotlight 59

Find Information with Metadata
Using Spotlight

Click the Spotlight (magnifying-
glass) icon on the right side of the
menu bar.

TIMESAVER Press A+Space
bar to open Spotlight. 

In the Spotlight field, type
code:keyword. Use quotation
marks around text to search for an
exact phrase.

Where the code is a category, such
as kind, date, modified, or author,
and keyword is a specific type of
category.

Here are some examples:

◆ kind:preference network
displays the network system
preference on your computer. 

◆ kind:contact steve displays all
the contacts with the name
steve on your computer. 

◆ kind:music by:”Bruce
Springsteen” displays all music
by Bruce Springsteen.

◆ date:today kind:email displays
all the email for today on your
computer. 

2

1

Did You Know?
You can quickly cancel a Spotlight
search. Press the Esc key to close the
Spotlight menu and erase what you’ve
typed. Now, you can type a new
search. Press the Esc key again to
cancel the entire search. To cancel the
entire search in one step, press
A+Space bar again, A+period, or
A+Esc.

Using Boolean Operators to Help Your Search

If you can’t find the information you are looking for using the Spotlight
field or Search field, you can use boolean operators (AND, OR, NOT,
and dash (-) for AND NOT to exclude items) to refine your help search.
For example, typing report AND proposal finds both words, typing
report OR proposal finds either report or proposal, while typing report
NOT proposal finds report, but excludes proposal. If you type report -
proposal, Spotlight finds report but not proposal. You can also use key-
words in your search with boolean operators. For example, typing
kind:pdf report AND kind:presentation proposal, finds PDF documents
with report and presentation files with proposal.

For Your Information

Find Code:Keyword

Program kind:app, kind:application

Address book contact kind:contact

Folder kind:folder

Mail message kind:email, kind:mail message

iCal appointment kind:event

iCal task kind:to do, kind:todo

Image, picture kind:image

Movie kind:movie

Music or Sound kind:music, kind:audio

PDF file kind:pdf

System Preference kind:preference, kind:system preference

Safari bookmark kind:bookmark

Font kind:font

Presentation kind:presentation

Week date:this week, date:next week

Month date:this month, date:next month

Year date:this year, date:next year

Today date:today

Tomorrow date:tomorrow

Yesterday date:yesterday

Find Code and Keywords



If you can’t find what you’re looking for on the Spotlight menu with the
20 most likely matches, you can click the Show All in Finder command
at the top of the Spotlight menu to open the Spotlight window and view
the complete list of matches organized by category. The Show All in
Finder command  displays the results of your search by retrieving con-
tent on your entire computer that matches the criteria. The Search bar,
located below the toolbar, indicates the search location and type,
which is “This Mac,” folder or disk name, such as “Documents” or “All
My Files,” and “Shared” by default. You can search your entire com-
puter (This Mac), your Home folder (All My Files), or shared network
computer by the file name and the contents of a file.
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Finding Information 
in the Spotlight
Window

Open and View the Spotlight
Window to Locate Information

Click the Spotlight (magnifying-
glass) icon on the right side of the
menu bar.

TIMESAVER Press
Option+A+Space bar to open
Spotlight window directly. 

In the Spotlight field, start to type
what you want to find. 

Click Show All in Finder on the
Spotlight menu. 

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left window corner. 

To narrow or change the search,
type the text you want to find in
the Search field. 

To open an item, double-click the
item or use the arrow keys to
scroll down the list, and then press
Return.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.
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Narrow Results in the Spotlight
Window

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window.

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left corner of the
window. 

In the Search bar, click the button
with the search location you want:

◆ This Mac. Searches all the
disks on your computer.

◆ All My Files. Searches your
Home folder.

◆ Server, Volume or Folder Name.
Searches only the currently
opened server, volume, or
folder. The item name appears
in quotes in the Search bar.

◆ Shared. Searches shared
folders on disks and computer.

To narrow or change the search,
type the text you want to find in
the Search field. 

To open an item, double-click the
item or use the arrow keys to
scroll down the list, and then press
Return.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.

6

5

4

3

2

1
1

3

5

2

4

6

Searching Made Easy

You can add text to the Spotlight Comments field in the Get Info dialog
for a specific file or folder that you can quickly search for using
Spotlight later. Control-click a file or folder, click Get Info, and then
type the text you want in the Spotlight Comments field. 

For Your Information
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If the list of Spotlight results is too long to find the results you want, you
can revise your search text in the Search field or use the Search bar to
filter, or narrow down, the list. The Search bar allows you to filter down
the Spotlight results by location and type. The left side of the Search
bar provides buttons to filter the search results by where the informa-
tion is stored, such as This Mac (your entire computer), All My Files
(your Home folder), or Shared (your networked computers), if available.
After you select where, you can select how. You can filter the result by
whether the search criteria is in the content of a file or the file name of
the results. If you want to further narrow down the Spotlight results,
you can add other search criteria using file attributes.

Filtering Spotlight
Results

Filter Spotlight Results

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window, and then
perform or narrow a search.

The Spotlight window displays the
results of your search by category.

In the Search bar, click the button
with the search location you want:

◆ This Mac. Searches all the
disks on your computer.

◆ All My Files. Searches your
Home folder.

◆ Server, Volume or Folder Name.
Searches only the currently
opened server, volume, or
folder. The item name appears
in quotes in the Search bar.

◆ Shared. Searches shared
folders on disks and computer.

To clear a search, click the Close
button (x) in the Search field.

When you’re done, click the Close
button.
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Change Spotlight Criteria in the
Spotlight Window

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window.

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left corner of the
window. 

Click the Action button, and then
click Show Search Criteria.

The Spotlight items option appears
in the first Search pop-up,
indicating Spotlight results in the
window.  

Click the Add (+) button, and then
specify the criteria you want.

Click the first Search pop-up of the
second criteria item, and then
select or type the search criteria.

◆ Select Other on the pop-up to
display a complete list of
searchable attributes.

Click the second Search pop-up of
the second criteria item, and then
select or type more specific
search criteria.

To remove search criteria, click
the Remove (-) button.

Click the Action button, and then
click Hide Search Criteria.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.

9

8

7

6

5

4

3

2

1

8

3

6

59 4 2

Other
available
search
criteria



64 Chapter 3

After you perform a search using the Spotlight window, you can use the
Arrange By button, Arranged By submenu on the Action menu or the
column header button in List or Cover Flow view to group and sort the
results of your search to make it easier to find what you’re looking for.
Clicking on one of the column header buttons—such as Name, Kind, or
Last Opened (default options)—in the search result window in either List
or Cover Flow view, sorts the files and folders by the type of information
listed in the column. If the columns are not organized in the order you
want, you can use the mouse to quickly drag a column header to
rearrange them.

Grouping and Sorting
Spotlight Results

Group and Sort Spotlight Results

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window, and then
perform or narrow a search.

The Spotlight window displays the
results of your search by category.

Click the List View or Cover Flow
button on the toolbar to display the
search results in list form.

Click a column header name
(default shown) to sort the file and
folder in ascending or descending
order:

◆ Name. List in alphabetical order
by element name.

◆ Kind. List by kind of item,
including applications,
documents, or images.

◆ Last Opened. List by the date
you last opened it.

To change the view options, click
the Action button, click Show
View Options, select options, and
then click the Close button.

When you’re done, click the Close
button.
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Select view options for
Spotlight search results
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After you perform a search using the Spotlight window, you can
Control-click an item to display a shortcut menu and get more informa-
tion about an item in the Spotlight results. When you Control-click an
item, the shortcut menu allows you to open the item, get information
about the item from the Get Info dialog box, locate the item in the
Finder, display a slide show for graphic items, or create an e-mail with
attachments using Mail.

Working with
Spotlight Results

Work with Spotlight Results

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window, and then
perform or narrow a search.

The Spotlight window displays the
results of your search by category.

Select the item(s) you want.

Click the Action button, and then
click the option you want:

TIMESAVER Control-click or
right-click  the items(s) you want.

◆ Open. Opens the selected
item(s).

◆ Open With. Opens the selected
item(s) with a specified
application. Point to Open With,
and then select an available
application.

◆ Open Enclosing Folder.
Displays the selected item(s) in
a Finder window.

◆ Get Info. Opens the Get Info
dialog box with basic file infor-
mation for the selected item(s).

◆ Quick Look. View the contents
of a file or folder without
opening it.

When you’re done, click the Close
button.
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You can change Spotlight preferences to customize the way you use
Spotlight. You can specify the categories, such as Applications,
Documents, Folders, and so on, you want or don’t want to include in a
Spotlight search. In addition, you can change the order of the cate-
gories to prioritize the way the results appears. If you prefer different
shortcut keys to display the Spotlight menu or open the Spotlight win-
dow, you can change them. When Spotlight performs a search, it looks
everywhere on your computer (except for someone else’s Home folder).
If you want to keep certain disks, partitions, or folders private, you can
add them to your privacy settings in Spotlight preferences. When you
add an item to the privacy list, Spotlight removes them from the
Spotlight index.
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Setting Spotlight
Preferences

Set Spotlight Search Results
Preferences

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

TIMESAVER Click Spotlight
preferences at the bottom of the
Spotlight menu (after you’ve
started a search).

Click the Search Results tab.

Select the check boxes you want
to include in the search results or
clear the check boxes you don’t
want to include in the search
results.

To change the order to the search
results categories, drag the
categories to the location you
want.

Click the Close button.5
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Did You Know?
You can use Spotlight everywhere
(almost). The Spotlight Search field is
also available in the Finder, Mail,
System Preferences, and Open and
Save dialogs to name a few.

Selecting the Default Search Location

You can specify the default search location for Spotlight. Click the
Finder menu, click Preferences, click Advanced, click the When per-
forming a search pop-up, then click Search This Mac, Search the
Current Folder, or Use the Previous Search Scope.

For Your Information
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Set Spotlight Privacy
Preferences

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

Click the Privacy tab.

Drag the items (disks, partitions, or
folders) to the list of non-
searchable items from the
desktop, or click the Add (+)
button, navigate to the item, and
then click Choose.

To delete an item, click the item,
and then press Delete or click the
Remove (-) button.

Click the Close button.

Set Keyboard Shortcuts for
Spotlight

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

Select the Spotlight menu
keyboard shortcut check box, click
the list arrow, and then select the
shortcut you want.

Select the Spotlight window
keyboard shortcut check box, click
the list arrow, and then select the
shortcut you want.

Click the Close button.4
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Searching for Files
Using the Find 
Window

Search for Files Using the Find
Window

Open a Finder window.

Click the File menu, and then click
Find.

TIMESAVER Press A+F to
open the Find window.

In the Search field, type the text in
which you want to search.

On the Search menu, select a
suggestion, such as Filename
contains “text” or a tag (New!), to
narrow the search as desired.

Click the button with the search
location you want:

◆ This Mac. Searches all the
disks on your computer.

◆ All My Files. Searches your
Home folder.

◆ Server, Volume or Folder Name.
Searches only the currently
opened server, volume, or
folder. The item name appears
in quotes in the Search bar.

◆ Shared. Searches shared
folders on disks and computer.

To change the search, click the
drop-down button, and then click
Filename or Everything.
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Spotlight provides a quick and easy way to search for files, but if you
need to perform a more specific search, the Find window can help you
search for what you need. The Find window lets you specify where and
how you want to search—This Mac, All My Files or “folder or disk
name,” or Shared—with either file contents or name and make relevant
suggestions as you type. You can narrow your search by selecting or
typing a specific list of criteria—such as name, location, size, kind, or
tag (New!)—available in the Find window. For example, you can search
for all graphic files with the .jpg extension you created last month that
contain web. After you complete a search, a separate results window
opens. Unlike the Spotlight, you can change the criteria and perform a
new search, and then compare the results. 

3

5 6

4



Chapter 3 Finding What You Want with Spotlight 69

Narrow Search for Files Using
the Find Window

Click the File menu, and then click
Find.

In the Search field, type the text in
which you want to perform an
initial search.

Click the first Search pop-up, and
then select or type the search
criteria; options vary depending on
the criteria.

◆ Kind. Finds files that are or
aren’t a certain kind.

◆ Last Opened Date. Finds files
that you last opened.

◆ Last Modified Date. Finds files
according to the date modified.

◆ Created Date. Finds files
according to the date created.

◆ Name. Finds all or part of a file
name (capitalization doesn’t
matter); select another option,
such as Contains, Starts With,
Ends With, or Is.

◆ Contents. Finds words inside
your file; handy if you don’t
remember the name.

◆ Other. Finds files based on
other selected attributes, such
as Tags (New!).

Click the second Search pop-up,
and then select or type more
specific search criteria.

To add search criteria, click the
Add (+) button, and then specify
the criteria you want.

To remove search criteria, click
the Remove (-) button.

The search results appear in the
window.

To pause or stop a search in
progress, click the X button.
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Setting a Search Location Preference

In the Finder Preferences dialog, you can specify a search location
preference. You can select any of the following options: Search This
Mac, Search the Current Folder, or Use the Previous Search Scope.
Click the Finder menu, click Preferences, click Advanced, click the
When performing a search pop-up, and then select the option you
want.

For Your Information

2
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In addition to searching for typical information, such as name, location,
size, or kind, you can also search for file specific metadata, such as vis-
ibility (visible files, not hidden one used by OS X), duration, dimensions,
pixel height and width, device make, layers, and tags (New!). There are
over 115 different metadata search attributes from which to choose. For
example, you can select search attributes to find visible files (not hidden
ones used by OS X), the duration of music and movies, the dimensions
of graphics or PDF documents, the device used to acquire a document,
and the names of layers in Photoshop.

Searching for Hard to
Find Information

Search for Hard to Find
Information

In the Finder, click the File menu,
and then click Find.

TIMESAVER Press A+F to
open the Find window.

◆ You can also use the Search
field located in every Finder
window.

In the Search field, type the text in
which you want to search.

To display only matches with
filename, select Filename contains
“text” on the Search menu.

At the top of the window, click the
button with the search location
you want: This Mac, All My files
or “folder or disk name,” or
Shared.

Click the first Search pop-up, and
then click Other.

Select the search attribute you
want to find, such as Tags (New!).

Click OK.7
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After you perform a search with the Find window, you can perform a
variety of file management operations directly with the Find window
results, which are similar to the ones you can perform in the Finder. For
example, you can get file information, and move, copy, rename, or
delete a file directly in the search results window. In addition, you can
display the location of a file in the search results window, and then
open its folder location or open the file. 

Working with Find
Window Results

Work with Find Window Results

After you perform a search with the
Find window, you can use the following
options to work with the results:

◆ Find the location of a file. Click a
file to display the location in the
Path bar at bottom of the window.

◆ Open the location of a file. Click
the File menu, and then click Open
Enclosed Folder.

◆ Open a file. Double-click the file
icon.

◆ Move or delete a file. Drag the file
to a new location or the Trash.

◆ Rename a file. Click its name,
select the text, and then type a
new name.

◆ Copy a file. Use the Copy and
Paste commands on the Edit
menu.

◆ Get file information. Click the File
menu, and then click Get Info. Add
criteria to Spotlight Comments for
use in Spotlight searches. 

◆ Sort the result by category. Click
the column header.

◆ Start a new search. Change the
text in the Search field, or click the
Close (x) button in the Search field
and type a new search.

◆ Close the search. Click the Close
button or press A+W.

Path bar

Double-click to open Click column to sort

Tags for the file
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A Smart folder is a self-updating folder that performs a search based
on the search criteria you set and save in the Search dialog box. You
can create a Smart folder by specifying a search in the Search dialog
box and then saving it as a saved search. For example, if you set up a
search for Last Opened and This week, and saved it as a Smart folder.
In the Sidebar, you can click the Smart folder to perform the smart
search, or Control-click it and click Show Search Criteria to edit it.

Creating and Using
Smart Folders

Create and Use a Smart Folder

Click the File menu, and then click
New Smart Folder.

Use the Add (+) button to specify
the search criteria you want to
save as a Smart folder.

Click the Save button.

Type a name for the Smart folder.

Specify the location where you
want to save the Smart folder. 

The default location is the Saved
Searches folder.

Select or clear the Add To Sidebar
check box to either add or not add
the Smart folder to the sidebar.

Click Save.

To use a Smart folder, click the
Smart folder icon on the Sidebar,
or navigate to the Saved Searches
folder, and then double-click it.

◆ The Saved Searches folder is
located in the Library folder,
which is located in the Home
folder.
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Smart
folder

Did You Know?
You can open a recent item. Click the
Apple menu, point to Recent Items, and
then click the recently used document
you want to open. 
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Edit a Smart Folder

Navigate to the Smart folder you
want to edit; you can click Smart
folder in the Sidebar to select to
display it.

Click the Action menu, and then
click Show Search Criteria.

Change the search criteria you
want to modify.

Click Save.

Click the Action menu, and then
click Hide Search Criteria.
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Did You Know?
Where’s the Smart folder? The Smart
folder is located in the Saved Searches
folder in the Library folder, which is
located in the Home folder. 

You can delete a Smart folder. Control-
click the smart folder in the Sidebar,
click Open Enclosing folder, and then
drag the Smart folder you want to
delete to the Trash icon. 

You can remove a Smart folder from
the Sidebar. Control-click the smart
folder in the Sidebar, and then click
Remove from Sidebar. The folder is
removed from the sidebar, however it
remains in the Save Searches folder.

You can add a Smart folder or other
folder to the Sidebar. Select the folder
in a Finder window or desktop, click
the File menu, and then click Add To
Sidebar.

Saved Searches folder

Items grayed out, not accessible.
Drag to trash to delete.
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When you have a question about how to do something in OS X, you can
usually find the answer with several clicks of your mouse. Mac OS X
Help is a resource of information to help you use OS X. The Mac OS X
Help Center is like an online book with a table of contents, complete
with a search feature, and additional links to the Internet to make find-
ing information a little bit easier. You can access help from the Help
menu in the Finder as well as many other OS X applications, such as
Safari and Messages; you can even switch between the different help
libraries using the Home button. If you see the Help button (question
mark) in a window or dialog, you can click it to get feature related help.
If you have an Internet connection, Help retrieves online updates to
Mac OS X Help content as necessary. For additional help and support
information, visit the Apple web site at www.apple.com.

Getting Help While
You Work

Browse for Help Information

In the Finder, or any other
application, click the Help menu,
and then click Help Center or
<application name> Help.

To select another Help, click the
Help for all your apps link, and
then click a help library.

Click a link in the Help window
until you find the topic with the
information you’re looking for.

Use the Help toolbar to
navigation help topics:

◆ Click the Back and Forward
button to view previously
viewed topics.

◆ Click the Action button to
change text size, find and high-
light text on current page, or
print current topic. 

◆ Click the Home button to return
to the first page of the help. 

◆ Click the Add Bookmark button
to add the current help topic to
bookmarks. Click Bookmarks
button to display the bookmark
list to open, remove or email. 

Click the Close button to quit
Help.
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Search Help fieldAction button

Find on page

http://www.apple.com
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Search for Help Information

In the Finder, or any other
application, click the Help menu,
and then click Help Center or
<application name> Help.

Click the magnifying glass in the
Search field, and then click
Include Product Support Results
to check or uncheck it.

Click in the Search field.

TIMESAVER Press the Tab key
to quickly go to the Search field.

Type the words you want to find
in the help topics, and then press
Return.

A list of matches appears with a
Relevance column ranking the
results by percentage.

Click the topic you want to read
in the search results list.

Use the navigation buttons (Back
and Forward) on the Help toolbar
to move between help topics.

Click the Close button to quit
Help.
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Did You Know?
You can start a new search in a new
window. Click the File menu, click
New, and then perform a new search.

You can print a help topic. Display the
help topic in the Help window, click the
Action button on the Help toolbar, click
Print, and then click Print again.

You can change the size of Help text.
Click the Action button on the Help
toolbar, click Make Text Smaller or
Make Text Bigger.

Possible matches
to search criteria
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In addition to using Spotlight to find files and other information on your
computer, you can also use Spotlight to quickly find help information.
When you click the Help menu, the Spotlight Search field appears at
the top, where you can type the help information you want to find and
display. You can access help from the Help menu in the Finder as well
as many other OS X applications, such as Safari and Messages. When
you select a help topic from the Help menu, the Help window appears
displaying the topic. If you want to display all the related help topics,
click Show All Help Results. A complete search results appears, where
you can double-click a topic to display it. If available, menu items
appear on the Help menu, where you can select it to display an blue
arrow pointing to the location of the menu.

Getting Help Using
Spotlight

Get Help Using Spotlight

Click the Help menu.

In the Spotlight Search field, start
to type what you want to find. To
find a specific phrase, place
quotes around it. For example,
“Preferences”

As you type, a menu begins to
display a list of everything
Spotlight can find in Help to match
what you’ve typed so far. As you
continue to type, the list changes.

On the Help menu, select one of
the following options:

◆ Display a Help Topic. Click the
Help topic item or use the
arrow keys to scroll down the
list, and then press Return to
open the Help window.

◆ Show All Help Results. Click
Show All Help Results to
display the search results for
help topics, and then double-
click the topic you want to
open the Help window.

◆ Display a Menu Item. Point to
the Menu item name to display
a blue arrow pointing to the
location of the menu item.

Click the Close button to quit
Help.

4

3

2

1
1 2Display menu item 3

Show all
results

4



541

Index

A
About This Mac, 529-530
Abstract Background, 102
Access Control Lists (ACLs), 494
Accessibility, 120-123. See also VoiceOver

Automator actions and, 516
accounts. See also Mail

Messages accounts, creating, 302-303
Acrobat Reader. See also PDF files

downloading, 219
actions. See Automator
ActionScripting, 521
activating/deactivating

fonts, 167
login window, 397
windows, 12-13

activities preferences, setting, 126-127
Activity Monitor, 458-459
Address Book. See Contacts
Administrator, 396

file permissions, setting, 400
master password, restoring, 410-411
Safari preferences, setting, 261
in Simple Finder, 94

Adobe Acrobat. See also PDF files
downloading, 219

AIM, Messages with, 299, 303
with Contacts, 148-149

AirDrop
sending files wirelessly, 437
My Card, 151
Photo Booth, using with, 345
sharing, 49

AirPlay mirroring
displaying AirPlay menu, 344, 470-473
multiple monitors, 472-473
selecting AirPlay device, 344, 470-473

changing AirPlay audio, 478-479
AirPort. See also Wi-Fi connection

Admin Utility, 444
configuring connection, 228
desktop icon, 5
Messages with, 304
with Mac for Windows, 481, 488
making Internet connection with, 234
multiple connections with, 229
network port configuration for, 233
printers, sharing, 212-213
setting up, 232

AirPort Extreme Base Station, 497
share a printer, 213

AirPrint, 208
alerts

changing sounds, 114
forms, sending nonsecure, 251
Messages alerts, 321
speaking voice for, 118

aliases, 77, 405
creating, 90-91

alignment
of document text, 188
of e-mail message text, 279
of tables, 195

All My Files, 30-31
AND operator, searching with, 59
animated GIFs

creating, 309
movies as animated GIFs, exporting, 

347
anti-aliasing, 100-101
Anywhere mode, 178
AOL and Messages, 227, 299-302

setting up accounts, 268
appearance (general) options, changing, 

100-101
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Apple
sending diagnostic & usage data to, 408

Apple Account number for iTunes Music
Store, 330

Apple Background, 102
Apple Developer Connection website, 172
Apple Events, sharing, 421
Apple Hardware Test, 464
Apple ID

password, changing, 410-411
Apple Magic Mouse, 6, 35, 136

Dashboard preferences, changing, 169
with Mac for Windows, 488

Apple Push Notifications (APN), 392-393
Apple Remote, 481.

iPod Hi-Fi, 325
with Mac for Windows, 481, 488

AppleScripts, 135
with Automator, 526
basics of, 521
displaying Script menu, 522
example Scripts folder, opening, 523
iCloud, 364, 366
opening from Scripts menu, 525
ready-make AppleScripts, using, 522-523
recording, 524
with Reminders, 388
Script Assistant, 522, 524-525
templates, starting new, 524
writing, 524

AppleTalk printers, installing, 208-209
Apple TV

AirPlay mirroring, 344, 470-473
multiple monitors, 472-473
export from QuickTime, 352-353
streaming to, 344, 470-473

applications, 1, 131. See also aliases; third-
party applications

automating updates, 447
different program, opening documents

with, 141
full screen, using, 139
iCloud enabled, 364-367
icons, 10
Info window, information in, 52-53
installing, App Store, 132-133
installing third-party applications, 134
launching, 136

list of, 135
nonresponding, quitting, 142
opening, 138
quitting, 142
showing/hiding, 140
Spotlight searches, keywords for, 59
switching between, 140-141
System Information, viewing system

information with, 461
uninstalling, 133, 446
updating, App Store, 446

Application Services, using, 450
sharing, 49

Applications folder, 28-29
App Nap, 110

Monitor energy, 458-459
App Store, 135

Apple Push Notification, 132
buy and download apps, 132-133
getting OS X, 531
iCloud, for, 356
install apps, 132-133
Notification Center, 390-393
preferences, 447
using with Launchpad, 136
security, downloading, 407
updating, 446-447

archiving. See also backing up
Contacts data, 147
Create Archive command, 449
e-mail, 291

ARPANET (Advanced Research Projects
Agency Network), 227

Arrange By button and menu, 34
arrows in dialogs, 9
Assist Me, help with, 423
attachments

Calendar event attachments, working
with, 374

deleting from e-mail, 287
with instant messages, 314
in replies to e-mail, 285
saving files, 287
sending files as, 286
Spotlight results as, 65
viewing, 286-287

audio chats. See Messages
audio MIDI devices, configuring, 478-479
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authentication preferences for Bluetooth,
431

AutoFill for Safari forms, 250-251
settings, iCloud, 416
settings, Safari, 417
using with Keychain, 418

Automator, 135, 507
Action list, 508-509
actions, 507

adding, 514
recording actions, 516
variables to action, adding, 515

AppleScripts with, 526
Description view, 508-509
example workflow

modifying, 513
opening, 512
working with, 512

existing workflow, opening, 511
iCloud, 364, 366
input and output, controlling, 513
introduction to, 508-509
Library pane, 508-509
modifying example workflow, 513
plug-ins with, 513, 520
printing workflow, 519
recording actions, 516
with Reminders, 388
running and saving workflows, 518-519
Search box, 508-509
starting, 510
stopping workflow, 518
toolbars, 508-509

customizing, 519
Variable list, 508-509
variables to action, adding, 515
Watch Me Do action, 516
window, parts of, 508-509
Workflow log and panes, 508-509
Workflow variable list, 508-509
working with workflows, 517

autosaving TextEdit preferences, 204
Auto Save, 164

duplicating document, 164
locking/unlocking documents, 164
reverting to last saved, 164
tagging, 164

using with 
Automator, 519
Preview, 162-163
TextEdit, 200-201

B
Back button on toolbar, 19
backdrops in Photo Booth, 347
backgrounds

desktop backgrounds, selecting, 102
in e-mail message text, 279

backing up, 493. See also archiving; disk
image; Time Machine

Calendar, exporting, 379
on CDs or DVDs, 506
compressed files and folders, 449
e-mail, 291
encryption, 494
formatting, backups prior to, 452
iOS devices, 359
iTunes library, 335

baseline for characters, changing, 192
BBEdit, 450
BinHex format, 259
birthday calendars, 373

Contacts, 148-149
blocking

e-mail, 294-295
Messages buddies, 322
pop-up windows, 264

Bluetooth.
Application Services with, 450
desktop icon, 5
with Mac for Windows, 481, 488-489
making Internet connection with, 234
mouse settings, 468
moving items with, 430
Passkey with, 429
preferences, setting, 431
printers, installing, 209
setting up network, 428-429
sharing, 421

boldfacing
document text, 188
e-mail message text, 279
fonts, 167
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Bonjour, 299
list of websites, viewing, 248
printers

installing, 208-209
sharing, 212-213

problems with, 304
starting messaging, 305
turning on, 304

bookmarks. See also Safari
with DVD Player, 349

Bookmarks Library. See Safari
Boolean operators with Spotlight search, 59
Boot Camp Assistant, 112, 481. See also

Mac for Windows
installing Windows on Mac, 484-485
preparing Mac for Windows, 482-483
removing Windows with, 490-491
upgrading from beta, 483

BOOTP (boot protocol), 231
borders for table cells, 195
bouncing e-mail, 294-295
Braille, VoiceOver supporting, 124, 127
brightness on monitor, changing, 470-471
broadband connection. See cable modems
browsers. See Web browsers
buddies. See Messages
bulleted lists, 194

in e-mail message text, 279
burning. See CDs; DVDs
Business, Dashboard displaying, 168-169
.bzip files, opening, 448

C
cable modems, 228

Ethernet with, 231
firewalls for, 425
sharing connection, 424

cache
for e-mail, 270
Safari cache, emptying, 246

calculations. See also Calculator
Calculator, 135

conversions, performing, 152-153
Dashboard displaying, 168-169
working with, 152

CalDAV 
setting up accounts, 268

workplace calendar server, 378-379
Calendar, 135. 

adding calendar accounts, 370
adding calendar events, 374
attachments for event, working with, 374
Automator workflow from, 520
backing up calendar, 379
birthdays, adding and showing, 379
creating calendars with, 372-373
Dashboard displaying, 168-169
deleting events, 375
details of event, editing, 375
editing calendar events, 374-375
full screen app, using, 139, 370-371
groups in calendar, creating, 372-373
importing/exporting events, 379
inviting attendees, 376
maps, 374-375
preferences, changing, 373
printing calendar, 377
publishing calendar, 378
reminders

creating, 384
printing, 377

shared calendars, finding, 378
Spotlight searches, keywords for, 59
subscribing to calendar, 378-379
sharing, iCloud calendar, 380-381
travel time, 374-375
view, changing, 371
viewing window, 370
weather forecast, 374-375

CardDAV 
Contacts, 150-151
setting up accounts, 268

calendars. See Calendar
cards. See also vCards
case-sensitivity

for finding/replacing text, 186
of passwords, 3

CD-ROMs, CD-Rs, CD-RWs, 29, 54
sharing, 420-421

CDs. See also iTunes
adding/removing files/folders from, 55
backing up files on, burning, 506
creating, 55
disk image, burning from, 503
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erasing, 456
music CDs, burning, 335
preparing to burn, 54
sharing, 420-421
Sidebar, burning disk with, 18
start settings, changing, 113
System Information, 461
uneven CDs, loading, 29

cell phones.
Bluetooth preferences, setting, 431
iPhones with iTunes, 341

cells in tables, 194-195
center-alignment

of document text, 188
of tables, 194

change of address notification, 146
characters

baseline, changing, 192
for file names, 44
spacing, changing, 192
special characters, inserting, 198

check boxes in dialogs, 9
check marks in menus, 7
Chess, 131, 143
children. See parental controls
Chinese handwriting, 179
cleaning up

files and folders set by clean up, 35
Icons view, items in, 34-35

clicking with mouse, 6
Clipboard

document text on, 176-177
web page text, copying, 257

Close button for windows, 12
closed captioning in QuickTime Player, 351
closing

dialog options, 9
documents, 201
windows, 12-13

Cloud. See also iCloud
accounts, 268, 269, 270-273
Back to My Mac, 360
calendar sharing, 380-381
Contacts, 146-147, 150-151
Find My Mac, Find My iPhone, 361, 

362-363
introduction, 355
iTunes, 326, 330-331, 341, 343

preferences, 96, 358-359
setting up, Mac and PC, 356-357

setting up account, 268
sharing files, 358-359
sign in and out, 356-358
storage, manage, 359
using, on Mac, 364
web browser, using, 362-363

collating print output, 216
color labels

for files and folders, 42-43
for Find window searches, 69
names, changing, 43

Color Picker, selecting with, 475
colors. See also ColorSync

Color Picker, selecting with, 475
Digital Color meter, using, 474
for document text, 188
with DVD Player, 349
for e-mail message text, 279
for fonts, 167
highlight colors, changing, 100
for instant message text, 312-313
monitor options, 470
palettes, selecting, 475-476
printer speed and, 206
printing, matching for, 217
for quoted text, 284
of Sticky Notes, 165

ColorSync
for fax documents, 225
matching colors to device with, 476-477
for printed documents, 217

columns. See also List view; tables
windows, headings for, 12

Columns view, 32
customizing window views, 82-83
keyboard options in, 39
Preview column, 39
viewing folders in, 39

Comic Book effect, 347
commands, 7. See also specific commands

Startup commands, 405, 411
VoiceOver commands, 128-129

comments
Info window options, 53
in Keychain, 414
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compatibility of hardware devices, 480
compressing/uncompressing

attachments, files for, 286
compressed files, 449
downloaded applications, 133
files and folders, 35
restoring compressed files, 449
Safari, disk images in, 259
Stuffit Expander, opening compressed

files with, 35, 133, 448
computers. See also networks

Find window searching, 68
information, 530
iTunes, authorizing/deauthorizing, 326
local name, changing, 421
maintaining, 445
recover entire computer, 501-502
several computers, connecting, 434-435
stand-alone computers, starting on, 2

Console utility, viewing system messages
with, 460

Contacts, 131, 135.
adding in Mail with, 275-277
archiving data, 147
Bluetooth with, 428
creating, 146-147
Dashboard displaying, 168-169
Directory for sharing information, 151
editing contact information, 148-149
faxes, addressing, 224
images, adding, 148
iPhoto pictures from, 148
managing contacts, 150
Messages buddies from, 308
pictures to contacts, adding, 148
printing from, 149
Safari Favorities bar, adding to, 248-249
sending e-mail from, 276-277
sharing, 150-151
Smart Addresses, using, 276
Spotlight searches, keywords for, 59
subscribing to, 151
vCards, 147, 150-151

contents, Find window searches by, 69
contextual menus, 8
conversions with Calculator, 152-153
cookies, 262-263

deleting, 266

cool genie effect, 89
copies for printing, 216
Copy command, 46
copying. See also drag-and-drop

Automator workflows, 517
documents, text in, 177
with Exposé, 47
files and folders, 46-47
Find window files, 71
formatting, 197
hard disk, 453
icons, 10-11
ruler, 189
Sidebar, copying folders with, 18
web page text, 257
Windows and Mac OS X, files between,

488-489
copyrights

documents, inserting in symbol in, 198
iTunes and, 333
spacing for symbol, 192
web page text, copying, 257

Cover Flow, 32
customizing window views, 82-83
iTunes, working with music in, 329
viewing files in, 38

cover pages, creating, 217, 221
CPU activity, viewing, 459
Create Archive command, 449
credit cards

AutoFill with Safari, 250-251, 416-418
for iTunes Music Store, 330

CSS, 172
currency conversions, calculating, 152-153
Customize Toolbar dialog, 84-85
customizing

Automator toolbars, 519
Dock, 88-89
DVD Player, 349
Exposé, 92
fonts, 167
keyboard shortcuts, 467
QuickTime Player, 350-351
Safari window, 236
Sidebar, 86-87
Spaces, 93
views, 32
widgets, 171
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Cut command, 46

D
Dashboard, 135

deleting widgets, 170-171
full screen app, using, 139
installing widgets, 170
preferences, changing, 169
pre-installed widgets, using, 168-169
showing/hiding widgets on, 168
Web Clip widget, creating, 172
working with, 168

Dashcode, 172
data detector, 181
dates and times

announcing, 105
files and folders arranged by, 35
international options, changing, 106-107
menu bar clock, using, 105
setting, 104-105
showing, 105
Spotlight searches, keywords for, 59
time zones, setting, 104
World Clock, displaying, 168-169

deleting. See also Dock; Messages; Mail;
Safari

aliases, 90
attachments from e-mail, 287
Automator workflows, 517
Calendar events, 374
Contacts, 148-149
Dashboard widgets, 171
documents, text in, 176
downloaded file, 259
e-mail, 290-291
files and folders, 50
hardware devices, 480
Keychain names, 412-413
List view, columns in, 37
printers, 208-209
print queue, job from, 220
recently used documents, 175
Safari History list entries, 246
securely deleting files and folders, 51
stacks from Dock, 21
third-party preferences, 97
toolbar icons, 85

user accounts, 399
design themes, 5
desktop. See also icons

backgrounds, selecting, 102
introduction to, 4-5
screen, 2

Desktop folder, 30-31
desktop printers, using, 217
Development menu, Safari, 261
Devices section, Sidebar, 18
DHCP (Dynamic Host Configuration

Protocol), 231
dialogs

closing options, 9
language options, setting, 106-107
navigating in, 9

dial-up connections, 230
dictation, 116-117
Dictation & Speech preferences, 97, 116-117
Dictionary, 135, 173. See also spell and

grammar checking
adding words to, 182
AppleScript dictionary, Automator, 526
Dashboard displaying, 168-169
looking up words with, 184
parental controls, setting, 185
preferences, setting, 184-185
recent searches, viewing, 185

Digital 8 camcorders with iMovie, 354
digital cameras. See Image Capture; iPhoto
digital certificates with Keychain, 412
Digital Color meter, 474
digital hub, cloud (iCloud), 355, 369
Digital Video (DV) camcorders, 303
directions, Maps, 158-159
Directory, 135

Contacts information, sharing, 151
disabled persons. See Accessibility
disk file system, 451

activities, monitoring, 458-459
Console, viewing system messages with,

460-461
copying disk, 453
formatting disks, 452
optimizing disk, 455
problems, fixing, 454
System Information, viewing system

information with, 461
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disk image
blank disk image as backup, 503
burning CD/DVD from, 503
creating, 502-503
restoring to disk, 505

disk space, freeing, 453
disks. See also disk file system; hard drive

ejecting and mounting disks, 56
opening/viewing, 28-29

Disk Utility, 54. See also backing up; disk
file system

copying disk, 453
formatting disks, 452
repairing disks, 454
repairing disk permissions, 455
restoring disk images with, 505
Windows, removing, 490-491

display. See monitor
preferences, 470-473

.dmg file format, 448
DNS (Domain Name Server), 228

for modems, 230
Do Not Disturb, Notification Center, 390-393
Dock, 5. See also showing/hiding

aliases on, 90-91
applications, launching, 136-137
customizing, 88-89
deleting

items, 89
stacks, 21

Launchpad, using, 136-137
moving items from, 89
showing/hiding, 88

hidden Dock, displaying, 20
stacks, 21

Simple Finder, 94
stacks, 21

documents, 173. See also attachments;
Dictionary; faxing; HTML 

bulleted lists, adding, 194
character spacing, changing, 192
closing, 201
copying text, 177
corrections in, 180
creating, 174
deleting text, 176
different program, opening with, 141
editing text, 176-177

existing documents, opening, 175
file formats for, 174
files, adding, 199
finding/replacing text in, 186-187
formatting

copying/pasting, 197
text, 188

grammar-checking, 182-183
handwritten text, inserting, 178-179
hyphenation, setting, 191
icons, 10
images, adding, 199
inserting text, 176
line spacing, changing, 193
lists, adding, 194
Microsoft Word file, saving as, 174, 200
movies, adding, 199
moving text, 177
numbered lists, adding, 194
opening, 30-31
page breaks, inserting and deleting, 193
Page Setup options for, 214
paragraph indents, setting, 191
paragraph tabs, setting, 190
PDF files, saving as, 219
Plain Text files, saving as, 200-201
previewing printed documents, 218
protecting, 200
read-only files, saving documents, 200
recent documents, opening, 175
RTF file, saving document as, 174, 200
rulers, using, 189
selecting text in, 176
spacing

character spacing, changing, 192
line spacing, changing, 193

speaking text in, 185
special characters, inserting, 198
spell-checking, 182-183
styles, applying, 196-197
tables, adding, 194-195
text wrap, changing, 191
typing errors, correcting, 180
undoing/redoing actions in, 180
viewing, 30-31
web page, opening, 238-239

Documents folder, 30-31
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dots per inch (dpi), 206
double-clicking with mouse, 6
downloading. See also iTunes; Safari

Acrobat Reader, 219
deleting downloaded file, 259
disk images, 259
installing downloaded applications, 133
printer drivers, 207
Safari, from, 236, 258-259
software, 446
stopping downloading of file, 259
widgets, 168

Downloads folder, 30-31
Downloads window

clearing settings, 266
working with files in, 258-259

dpi (dots per inch), 206
drag-and-drop

document text, moving/copying, 177
files and folders, copying/moving, 47

dragging
aliases, 91
with mouse, 6

drivers for printers, 207
Drop Box folder in Home folder, 410, 436
DSL (digital subscriber line), 228

Ethernet with, 231
sharing connection, 424

DVD Player, 135, 325
browsing movies with, 348
customizing, 349
key points, creating, 349
playing movies with, 348

DVD-R and DVD-RWs, 29, 54
sharing, 420-421

DVDs, 29. See also iDVD
adding/removing files/folders from, 55
backing up files on, 506
creating, 55
disk image, burning from, 503
erasing, 456
preparing to burn, 54
sharing, 420-421
start settings, changing, 113
System Information, viewing, 461
uneven DVDs, loading, 29

E
editing

Contacts information, 148-149
documents, text in, 176
keychains, 414-415
Smart folders, 72-73
tags, 19, 42-43

Edit menu Undo/Redo commands, 45
editing movies, 352-353
ejecting disks, 18, 56

desktop icon, 5
ellipses (...)

full text, showing, 36
in menus, 7

e-mail. See also Mail
embedding movies and images, 199
emoticons in instant messages, 312-313
empty Trash warning, turning on/off, 51, 81
encryption

backups, 494
Encrypt, from Finder, 28
FireVault using, 409
Recovery key, password, 410-411
Keychain data, 412

Energy Saver preferences, 110-111
energy

activities, monitoring, 458-459
App Nap, 110, 458-459
preferences, 110-111

entry fields in dialogs, 9
EPS (Encapsulated PostScript) files, 162
erasing

CDs/DVDs, 456
deleting files, 50-51
disk, 452-453
hard disk, 533

erase free space, 452-453
Esc key, 9
Ethernet. See also AirPort

configuring connection, 228
for LANs, 426
networks, 228
setting up connection, 231

Eudora mail, importing, 269
example workflow. See Automator
exporting. See importing/exporting
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Exposé. See also Mission Control
copying items with, 47
customizing, 92
Dashboard preferences, changing, 169
moving and copying files with, 47
using with Mission Control, 22-23
space with, 23

extensions, Safari, 260
external disks, 29

F
Facebook

Calendar events, 370, 372-373
Contacts, 148-149
Notification Center, 390-393

QuickTime, 352-353

Safari extension, 260-261

posting, Notification Center, 394

setting up account, 268, 370

sharing, 49, 344
FaceTime, 135

Contacts, 148-149
with Messenger, 316-317
Notification Center, 390-393
preferences, 323
starting, 323
using with Preview, 162-163
video call with iPad, iPod touch or 

Mac, 323-324
Fast User Switching, enabling, 406
favorites

folder, 31
style favorites, applying, 196-197

faxing, 205
automatically receiving faxes, 226
Contacts, addressing faxes from, 224
cover pages, creating, 217, 221
receiving faxes, 226
scheduling faxes, 225
sending fax documents, 224-225
sleep mode, turning off, 226
status of fax, checking, 225

Feedback window for speech recognition,
120-123

file extensions
different program, opening documents

with, 141

for document files, 174
Find window searching, 68
renaming files, effect of, 45
showing/hiding, 81

File Info window, 400
file management, 27
file permissions

for copying and moving files, 47
setting, 400

files, 1. See also aliases; Exposé; file 
permissions; Home folder;
naming/renaming

arranging files, options for, 35
Bluetooth, moving with, 430
colors, organization by, 42
Columns view, working in, 39
compressing, 35
copying, 46-47
Cover Flow, viewing with, 38
deleting, 50
documents, adding to, 199
e-mail as file, saving, 292
Icons view, viewing in, 34-35
Info window, information in, 52-53
instant messages, sending with, 312-314
kind

arrangement of files by, 35
Find window search for files by, 69

List view, working in, 36-37
moving, 46-47
Network Sharing Services, 420, 422-423
Quick Look, viewing in, 40
recently used files, opening, 138
restoring deleted files, 50-51
sorting by column, 37
Stationery Pad, 52-53

FileVault. See also Encryption
computer, protecting, 409
passwords with, 409
Recovery key, password, 410-411
turning on/off, 409

filters. See also Quartz Filters
Spotlight results, filtering, 62-63
viewing information on, 477

Final Cut Pro, 350-351
Finder, 1. See also CDs; DVDs; Finder

Preferences; indexing
Application Services with, 450
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Automator workflow from, 520
full screen, using, 12, 14-16
Help menu, 74
icons view, customizing, 82
introduction to, 4-5
mouse pointer in, 6
networks, browsing, 432-433
parts of a window, 12
Simple Finder, 94
Spotlight results in, 65
toolbar, customizing, 84-85
undoing actions in, 45
window opening, customizing, 80

Finder Preferences, 28, 77
Advanced preferences pane, 78
description of, 78
file extensions, showing/hiding, 81
General preferences pane, 78
icons on desktop, specifying, 79
Tags preferences pane, 78
Sidebar preferences pane, 78
spring-loaded folders, turning on/off, 48

finding/replacing
documents, text in, 186-187
Wrap Around option, 186-187

Find My Mac or Find My iPhone, 361, 
362-363

Find My Friends, 361
Find window

files, searching for, 68-69
hard to find information, searching 

for, 70
naming/renaming

files, 71
searches by name, 69

results, working with, 71
finger gestures

Trackpad preferences, 6, 469
Finger service, 444
firewalls, 229

configuring, 425
printers, sharing, 212-213

FireWire, 56
FireVault protecting, 409

flash drives, 29

Flickr

setting up account, 268

sharing, 49
Photo Booth, using with, 345

QuickTime, 352-353
Flight tracker, Dashboard display, 168-169
folders, 27. See also aliases; Exposé; nam-

ing/renaming; Smart folders; spring-
loaded folders

arranging folders, options for, 35
Automator workflow from, 520
bookmarks folder, creating, 248
colors, organization by, 42

folders
Columns view, working in, 39
compressing, 35
copying, 46-47
creating, 44
deleting, 50
icons, 10
Icons view, viewing in, 34-35
Info window, information in, 52-53
kind

arrangement of files by, 35
Find window search for files by, 69

List view, working in, 36-37
moving, 46-47
Quick Look, viewing in, 40
Recent Folders list, 41
restoring deleted folders, 50-51
Safari bookmarks, creating folder, 248
sorting by column, 37
Spotlight searches, keywords for, 59
types of, 28-29

Font Book, 131, 135
activating/deactivating fonts, 167
managing fonts with, 166

fonts
defined, 188
for document text, 188
for e-mail message text, 279
for instant message text, 312-313
locating, 167
on-screen smoothing, 473
Safari font preferences, setting, 261
size, 188
smoothing styles, changing, 100-101
Spotlight searches, keywords for, 59
TextEdit preferences, setting, 204
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forcing a restart, 462
foreign languages. See languages
formatting. See also documents

copying/pasting, 197
disks, 452
e-mail message text, 279
instant message text, 312-313
international options, changing, 106-107
TextEdit preferences, setting, 204

forms, filling out, 250-251
Forward button on toolbar, 19
forwarding e-mail, 284-285
frames, 235

printing web page frame, 254
full screen 

apps, using, 139
interface with DVD Player, 349
Mission Control, in, 23
Safari, using, 236, 236

G
Game Center

App Store, using, 144
getting started, 144
Notification Center, 390-393
parental controls, 403
playing chess, 143
playing online games, 144-145

general preferences, changing, 100-101
Genius, iTunes, 334, 336
gestures for ink

Ink Pad recognizing, 179
turning on/off, 130

gestures for trackpad, 6, 469
Trackpad preferences, 6, 469

Get Info button, 71
Get Info dialog box, 65
Gmail calendar account, 370
Go menu, 41
Google

Application Services with, 450
Calendar account, 370
Contacts from, 148-149
clearing search settings, 266
Dashboard displaying, 168-169
Smart Search field, 252-253
setting up accounts, 268

Gmail
setting up accounts, 268, 270-271

Grab, 450
screen shots, capturing, 161

grammar checking. See spell and grammar
checking

graphics. See also images
Quartz Extreme enhanced graphics, 102
RTFD files for, 174

grid settings, overriding, 35
grouping/ungrouping

Calendar, creating calendar groups, 372-
373

Spotlight results, 64
GUI (graphic user interface), 1, 468
.gzip files, 259
opening, 448

H
hackers, firewalls and, 425
handwriting

documents, inserting handwritten text
in, 178-179

Chinese, in, 179
ink preferences, setting, 130

hard drive, 29. See also disk file system
Find window searching, 68
FireVault protecting, 409
Info window, information in, 52-53
optimizing, 455
Recovery key, password, 410-411
System Information, 461
web page, opening, 238-239

hard to find information, searching for, 70
hardware, 463

Apple Hardware Test, 464
ColorSync, matching colors to device

with, 476-477
compatibility, checking for, 480
installing devices, 464
for Mac for Windows, 482
preferences, 96

viewing, 466
problems, preventing, 480
removing devices, 465
Safe boot, performing, 480
settings, viewing, 466
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HDTV, connecting to
display settings, 470-471
multiple monitors, 472-473

hearing impaired users, preferences, 120-
123

help
Assist Me, help with, 423
browsing for, 74-75
for Internet connection, 229
searching for, 74-75
with Spotlight, 76
VoiceOver help, 125

hexadecimal color values, 474
highlight colors, 100
History list. See Safari
Home folder, 30-31, 398

desktop, opening from, 31
Drop Box folder, 410, 436
Find window searching, 68
managing files with, 410
Public folder, 30-31, 410, 436
Shared folder, 410, 436

Home page. See Safari
hot spots, VoiceOver, 125, 128
HTML (Hypertext Markup Language)

Dashcode, 172
documents in, 174
links to HTML files, adding, 203
opening HTML documents, 202
plain HTML code files, creating, 202-203
TextEdit, creating HTML documents

with, 202-203
web page code, viewing, 256

HTTP (Hyper-Text Transfer Protocol), 239
hubs for LANs, 426
hyperlinks. See links
hyphenation, setting, 191

I
iBooks, 135

iBook Store, 154-155
iCloud, 356-357
reading, 157
markup, 158
purchasing books, 155
settings, 154
sleeping options, 111

using, 156-157
iCloud. See also Cloud

accounts, 268, 269, 270-273
Back to My Mac, 360
calendar sharing, Calendar, 380-381
Contacts, 146-147, 150-151
files, managing on Mac, 356
Find My Mac, Find My iPhone, 361, 

362-363
introduction, 355
iTunes, 326, 330-331, 341, 343
Keychain, 416-418
managing files on Mac, 368
Photo Stream, iPhoto, 364, 362-363
preferences, 96, 358-359
setting up account, 268
setting up, Mac and PC, 356-357
sharing files, 358-359
sign in and out, 356-357, 358
storage, manage, 359
using, on Mac, 364
web browser, using, 362-363

iCloud Photos
Notification Center, 390-393

icons. See alsoTrash
copying, 10-11
customizing views of, 82-83
deselecting, 10-11
on desktop, 4
disk icons, displaying, 29
Finder Preferences for displaying, 79
moving, 10-11
selecting, 10
Sidebar, removing icon from, 18
for Spotlight, 57

Icons view, 32
arranging items in, 34-35
customizing window views, 82-83
spring-loaded folders, opening, 48

iDVD, exploring, 54, 354
iListen, 118
Image Bar with DVD Player, 349
Image Capture, 135

Automator workflow from, 520
working with, 160

images. See also attachments
Contacts, adding images to, 148
documents, adding to, 199
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images (continued)
Messages buddy picture, changing, 309
previewing, 162-163
Safari, saving web page images in, 257
Spotlight searches, keywords for, 59

IMAP (Internet Messages Access Protocol),
271

mailboxes for, 289
iMovie, 354
Import Bookmarks command, 247
Import Image command, 450
importing/exporting. See also iTunes

animated GIF, exporting movie as, 347
Automator workflows, 517
Calendar events, 374
Contacts, importing, 147
iTunes, music from CDs to, 329
mailboxes to Mail, 269
MP3 players, exporting music to, 342
QuickTime, exporting movies, 352-353

Inbox. See Mail
indents

documents, 191
for e-mail message text, 279

indexing, 53, 57, 69
Info window, file, options, 52-53
infrared (IR) technology, 233, 325
ink-jet printers, 206
Ink Pad, 178
ink preferences, setting, 130
iMessage. See also Messages

account, 302
with iOS devices, 300, 319
using to send and receive messages,

312-313
video chat, 316

installing. See also uninstalling
Dashboard widgets, 170
hardware devices, 464
printers, 208
software, 446
third-party applications, 133
Windows on Mac, 484-485

instant messages, 299. See also Bonjour;
Messages

SMS (short message service) text, 304
Intel-based Mac computers. See Mac for

Windows

international options, changing, 106-107
Internet, 227. See also AirPort; download-

ing; firewalls; wireless connections
Assist Me button, 229
connecting to, 228-229
firewall, 425
hardware problems, checking on, 480
history of, 227
modems, setting up, 230
multiple connections, 229, 233
parental controls for, 402-403
searching, 252-253
security, 229
sharing connections, 229, 421, 424
songs, finding names of, 335
status menus for connecting to, 234

Internet Explorer, 227
Internet Radio, 325

iTunes window settings, 327
listening to, 339

iOS device (iPod touch, iPhone, and iPad)
Automator example workflow for, 512
synching with Contacts, 150-151
with FaceTime, 323-324
with iCloud, 355-363
with iTunes, 341, 343, 356-357
with Messages, 300, 312-313, 319

IP (Internet Protocol). See also printers
identifying address, 435
for ISPs (Internet service providers), 228
Sharing Service requiring, 420

iPad. See iOS device
iPhone. See iOS device
iPhoto

Automator example workflow for, 512
burning pictures to discs, 54
description of, 354
e-mail, adding photos to, 278
getting pictures for Contacts, 148
getting pictures for Messages, 309
iCloud, 356, 364-365
PhotoBooth, 345-346

iPod.
disks, 29
unmounting, 56

iPod touch. See iOS device
iSight, 131, 303. See also Photo Booth

with Mac for Windows, 481, 488
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using with Preview, 162-163
ISPs (Internet service providers), 228

attachments and, 286
Safari preferences, setting, 261

italicizing
document text, 188
e-mail message text, 279
fonts, 167

iTunes, 54, 135, 325.
account, authorize or deauthorize, 326
aspects of iTunes, viewing, 331
automatically playing CDs with, 328
backing up library, 335
Boot Camp Assistant and, 481
Contacts, 150-151
copyright laws and, 333
Dashboard displaying, 168-169
downloading

from CDs, 329
from iTunes Store, 330-331

Genius playlist, 334, 336
with iCloud, 330-331, 356-357, 364
iCloud, 356-357, 358-359, 364
iMix, creating, 333
importing/exporting

CDs, music from, 329
MP3 players, exporting music to, 342
playlists, 332, 334

Internet Radio, 339
iOS devices (iPod, Phones, and iPad)

with, 341, 343
iTunes Match, 331
iTunes Radio, 338
with Mac for Windows, 488
MiniPlayer, using, 327
multiple libraries, creating, 329
Notification Center, 390-393
Notification options, 333
playing music from CDs, 329
playlists

burning music CDs from, 335
creating, importing/exporting, 332-334
media, adding, 334
Smart Playlists, building, 332-333

podcasts, listening to, 340
preferences, setting, 328, 342, 343
radio list, adding stations to, 338, 339

Remote App, 337
setting up, 326
sharing at home, 337
Smart Playlists, building, 332-333
starting, 326
Up Next list, 327, 336
viewing window, 327
volume control for, 114

iTunes Store, 326-327
iMix, creating, 333
using, 330-331

iWork
iCloud, 362-363
in Preview, 162-163

J
Jabber and Messages, 299, 302
Java, Safari enabling, 262-263
JavaScript

Dashcode, 172
Safari, enabling in, 262-263

joining iCloud community, 355, 356-357
Junior voice, 118
junk e-mail, 294-295
justification

of document text, 188
of tables, 195

K
kerning, changing, 192
keyboards

Accessibility options, 120-123
Calculator, using with, 152
changing settings, 467
international options, changing, 106-107
with Mac for Windows, 481, 488-489
VoiceOver help, 128

keyboard shortcuts, 7
applications, switching between, 141
customizing, 467
with DVD Player, 349
for Exposé, 92
Spotlight, setting for, 66-67
turning on, 9
with VoiceOver, 128

Keyboard Viewer, 106-107
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Keychain
access controls, setting, 415
adding keychains, 412
description of, 412-413
iCloud, 356-358, 364, 413, 416-418
modifying, saving keychains, 414-415
working with, 412-413

Keychain, iCloud
settings, 416-417
using with AutoFill, 418

keywords
for Find window searches, 69
for Internet searches, 252
for Spotlight searches, 59

kilometer to miles conversions, 152-153

L
labels. See also color labels

Contacts labels, 146, 149
files and folders arranged by, 35

landscape orientation printing, 215, 216
languages

dictionary sources, 184
in documents, 175
Info window options, 53
international options, changing, 106-107

LANs (local area networks). See also AirPort
Ethernet connection for, 231
Messages with, 304
setting up, 426-427
with Sharing Service, 420
Windows computers, connecting from,

441
laser printers, 206
Launchpad

adding or removing apps, 136
using folders, 136-137
using with App Store, 132-133

layout
for fax documents, 225
for printing, 217

LDAP (Lightweight Directory Access
Protocol) 

Contacts, 150-151
setting up accounts, 268

left-alignment
of document text, 188

of tables, 194
left indent marker, 191
libraries. See iTunes
Library folder, 28-31
Library pane on Automator window, 508
Light Tunnel effect, 347
line height/spacing, changing, 193
Linkedin

setting up account, 268

posting, Notification Center, 394
Shared Links, 236-237, 244

setting up account, 268

sharing, 49
links

e-mail message, sending links in, 286
to HTML code files, 203
instant messages, sending with, 314

lists. See bulleted lists; numbered lists
List view, 32

color labels, sorting files and folders, 42
customizing window views, 82-83
rearranging, widening columns in, 37
showing/hiding folders in, 36
sorting files and folders in, 37-38
spring-loaded folders, opening, 48

local disk, 29
location services, 408

Maps for, 158-159
locking/unlocking preferences, 99
logging in, 1

items, specifying, 404
with Network Sharing Services, 421

logging out, 25
Login window, 2

actions from, 3
activating, 397
bypassing, 3

lowering characters, 192
LTP Over IPsec protocol, 442

M
MacBinary format, 259
MacBook OS X DVD, keeping, 411
Mac Finder. See Finder
Mac for Windows, 481. See also Boot Camp

Assistant
installing Windows on Mac, 484-485
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Migration Assistant
between Mac and PC, 457

multiple internal disks, removing
Windows from computer with, 490

preparing, 482-483
removing Windows, 490-491
starting after installation of, 486-487
using Windows on Mac, 488-489

Mac information, 530
Mac OS X. See OS X
Magic Mouse. See Apple Magic Mouse
Magic Trackpad, 6, 35, 136
Mail, 135, 267. See also Contacts;

attachments
accounts

adding, 271
advanced options, setting, 273
managing, 272-273
setting up, 269, 270

addressing e-mail, 276-277
advanced account options, setting, 273
Application Services with, 450
archiving e-mail, 291
authentication of, 273
backing up e-mail, 291
BCc address field, 275
blocking e-mail, 294-295
bouncing e-mail, 294-295
Cc field, 276
composing e-mail, 275
conversation, organized by, 288-289
data detectors, managing information

with, 278
dates and times, setting, 104
deleting, 290-291

options, changing, 291
diverting incoming e-mail to mailboxes,

296
draft e-mail, saving, 292
Exchange, Microsoft, support, 268, 

270-271
Favorites bar, 281
file, saving e-mail as, 292
flagging, color-coded, 293-294
formatting message text, 279
forwarding e-mail, 284-285
full screen app, using, 139, 281
grammar-checking e-mail, 275

importing mailboxes and e-mail, 269
incoming e-mail, setting rules for, 296
instant message, replying to e-mail with,

284
junk e-mail options, 294-295
links in e-mail message, sending, 286
mailboxes

for backing up e-mail, 291
diverting incoming e-mail to, 296
new mailbox, creating, 288
organizing e-mail in, 289
Smart Mailbox, creating, 297
standard mailboxes, 288

Message List view, changing, 281, 283
new e-mail, checking for, 282
new mailbox, creating, 288
Notification Center, 390-393
offline viewing, keeping copies for, 273
opening e-mail, 282-283
Out of Office message, creating, 296
parental controls for, 402-403
passwords for, 269, 273
Photo Booth, using with, 345
photographs, adding, 278
preferences for addressing, 276-277
previous recipients list, sending e-mail

with, 276-277
printing e-mail, 291
priority to mail, adding, 275
quoted text in, 284
reading and receiving e-mail, 282-283
recovering deleted e-mail, 290
redirecting e-mail, 284-285
replying to, 284
resending messages, 295
rules, creating, 296
saving e-mail, 292
searching e-mail for text, 293
sending e-mail, 275
servers, 270-271

removing mail from, 273
sharing, web sites, 244
signatures, creating, 280
Smart Addresses, using, 276
Smart Mailbox, creating, 297
sorting messages, 289
speaking voice, adding, 278
spell-checking e-mail, 275
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Mail (continued)
Spotlight searches, keywords for, 59
starting, 269
stationery, adding, 278
threads, sorting e-mail by, 289
Trash mailbox, 288
VIPs, 298
window, viewing, 274

maintaining computer, 445
malware, preventing, 407
Maps, 135

events, Calendar, 374-375
directions, getting, 158
navigating, 158-159
Notification Center, 390-393
viewing, 158
weather forecast, Calendar, 374-375

master password, restoring, 410-411
maximizing/minimizing

changing options, 100
Dock, 88
iTunes window, minimizing, 331
slowing minimization, 89

me card, Contacts, 147
media

iTunes playlists, adding to, 332, 334
sharing media at home, 337
working with, 336

Media browser for Automator workflows,
517

memory
calculation results, saving, 153
Info window options, 53
system memory, viewing, 459

menu bar, 5
AirPlay, 470-473
Bluetooth placed on, 429
clock, using, 105
Displays icon on, 470
rearranging status icons on, 8
status of fax, showing, 225, 226

menus
contextual menus, 8
language options, setting, 106-107
pull-down menus, 8
working with, 7

Messages, 131, 135, 299. See also Bonjour
accounts, creating, 268, 302-303

adding buddies, 308
with AirPort, 304
alerts, setting, 321
animated GIF, creating, 309
appearance of chat, changing, 320
Application Services with, 450
audio chats, 316, 318
away messages, 306
backdrops, adding, 318
bandwidth speed for video chats, 

changing, 316-317
blocking buddies, 322
collecting chats in single window, 313
conversations, working with, 315
custom status messages, creating, 306
deleting, budding, 308, 311
downloading versions of, 303
e-mail, responding to, 284
emoticons, inserting, 312-313
files with message, sending, 314
formatting message text, 312-313
full screen app, using, 139
groups of buddies, managing, 310-311
help in, 74, 300
links with messages, sending, 314
Notification Center, 378-394
options, messages, 319
parental controls for, 402-403
passwords for, 303
performance and quality specs, 317
Photo Booth

effects, adding, 318
using with, 345
video clips in, 346

pictures
of buddies, 309
of video chats, 317

receiving instant messages, 312
recording video chats, 318
renaming buddy groups, 311
searching for buddies, 310-311
sending instant messages, 312, 394
sharing screens, 305
sharing, web sites, 244
signing in and out, starting, 300
status, changing, 306
Status menu, using, 306-307
Tab bar, 312-313
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turning on/off
groups, use of, 310
Status menu, 307

video chats, 316
backdrops, adding, 318
bandwidth speed, changing, 316-317
enhancing, 318
installing hardware for, 303
monitoring, 317
Photo Book effects, adding, 318
pictures of, 317
recording, 318

viewing window, 301
view of buddy list, changing, 311

metadata, 57
specific metadata, searching for, 70
Spotlight, finding information with, 58

microphones with Messages, 316
Microsoft. See also Mac for Windows;

Microsoft Word; Windows
Excel, Contacts for faxes with, 224
Exchange 2007, 2010 or later

calendar, 370
Contacts, 150-151
Internet Accounts, 268
Mail server, 268, 270-271
setting up account, 268

Internet Explorer, 227, 235
Office documents, in Preview, 162-163
Outlook/Outlook Express, importing 

e-mail to, 269
Microsoft Word

Contacts for faxes with, 224
documents as files, 174, 200
formatting text in documents, 188
opening documents in, 141

MIDI
devices, configuring, 478-479

Migration Assistant
between Mac and PC, 457

MiniDV camcorders with iMovie, 354
Minimize button for windows, 12, 15
mini restarts, 462
Mission Control, 135

copying items with, 47
customizing, 92-93
customizing with Dashboard, 169
moving and copying files with, 47

multiple displays, 472-473
using 22-23

Mobile Documents folder, 368
modems, 228. See also cable modems

configuring connection, 228
setting up connection, 230

monitors. See also colors
Apple TV, 344, 470-473
AirPlay, 344, 470-473
brightness on monitor, changing, 470-

471
detect displays, 470
display settings, changing, 470-473
fonts on screen, smoothing, 473
resolution, 470-471

mounting disks, 56
mouse. See also Apple Magic Mouse

Accessibility options, 120-123
changing settings, 468
pointer, 6
windows, resizing, 15
working with, 6

Mouse Keys, 120-123
movies. See videos
Movies folder, 30-31
moving. See also drag-and-drop; navigating

Bluetooth, items with, 430
Contacts, 148
Dock items, 89
documents, text in, 177
with Exposé, 47
files and folders, 46-47
icons, 10-11
Mailboxes on screen, 289
Safari, bookmarks in, 247
Sidebar, moving folders with, 18
spaces, window between, 23
windows, 14

MP3 players, exporting music to, 342
MR (Memory Recall) button, 153
multi-function devices, 206
Multi-Touch gestures, 6, 35, 136
music, 325. See also CDs; iTunes; MIDI

finding names of songs, 335
Spotlight searches, keywords for, 59

Music folder, 30-31
muting sounds, 114
me card, Contacts, 147
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N
naming/renaming. See also Find window;

Keychain
files and folders, 44-45

arranging by names, 35
Info window options, 53
Mailboxes, 289
Messages buddy groups, 311
Safari Bookmarks Library collection, 249
tags names, changing, 43
user accounts, short name for, 398

Nature Background, 102
navigating

in dialogs, 9
with VoiceOver, 125, 126
web pages, 238-239

nesting tables, 195
Netscape Navigator, 227, 235

Mail, importing e-mail to, 269
NetStat, 444
network disks, 29

Info window, information in, 52-53
Network Preferences pane, connecting to

Internet with, 234
network printers, 212-213

accessing shared printers, 212-213
installing, 208

networks, 419. See also AirPort; Bluetooth;
LANs (local area networks); network
printers; Network Sharing Service

activity, viewing, 459
Bonjour messaging on, 299, 304-305
connecting

with Assistant, 427
over local networks, VPN, 442-443
from Windows, 441

diagnostics, using, 427
Finder, browsing with, 432-433
other computers, connecting to, 434-435
port configuration, 233
privileges for users and groups, 

creating, 422
searching for files on, 433
sending files wirelessly, AirDrop, 437
setting up, connecting to with an assist,

427
several computers, connecting to, 434
Sidebar, accessing from, 433

System Information, viewing system
information with, 461

utilities, 444
VPN (Virtual Private Network), VLAN

(Virtual Local Network), connecting
with, 442-443

Windows, sharing Mac files with, 440
Windows computers, connecting from,

441
Network Sharing Service, 420-421

file sharing, setting up, 422-423
Internet Sharing, 424

Network Utility, 444
New dialog box, 511
no access for network users, 422
nonresponding applications, quitting, 142
notes. See also Mail; Sticky Notes

Keychain, adding secure notes with, 
412-413

Notes
accounts, 387
creating, 388-389
iCloud, 358, 364, 362-363
managing, 388-389
Notification Center, 390-393

Notification Center
gesture settings for, 469
get notifications, 392

from websites, 393

post to social network, 394
preferences, 96, 390-391
using, 392-393

Notifications preferences, Safari, 265
NOT operator, searching with, 59
NPR, listening to, 339
NSFNET, 227
NTFS, reformatting with, 484
NTSC format with iMovie, 354
numbered lists, 194

in e-mail message text, 279
numbering

international options, changing, 106-107
recent items, changing numbering of,

100-101
NumPad Commander, 125, 127

O
Open dialog box in Automator, 511
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opening
applications, 136-137, 138
Dashboard, 168
disks, 28-29
documents, 30-31, 141
Info window options, 53
recent applications and documents, 41
recently used applications, 138
Scripts menu, scripts from, 525
windows, 12-13

operating system, 1
optimizing hard drive, 455
Option buttons in dialogs, 9
orientation for printing, 215, 216
OR operator, searching with, 59
OS X, 494

applications, list of, 135
CD, restoring passwords with, 411
getting from App Store, 531
install, 528, 532-533
Migration Assistant, 457
OS X DVD, keeping, 411
preparing for, 528
recover entire computer, 501-502
reinstall, 528, 534
restarting with, 112
Server account, creating, 268
system requirements, 528
Time Machine for reverting to previous

version, 500-501
uninstall, 528
utilities, 528, 532-534
version, 529
Windows files, copying, 488-489

outlining
document text, 188
fonts, 167

Out of Office message, creating, 296

P
page breaks, inserting and deleting, 193
Page Setup

individual defaults, setting up, 215
for printers, 210
printing and range options, 214-216
for text wrap, 191

pages per minute (ppm), 206

PAL format with iMovie, 354
Palm OS devices. See PDAs (personal data

assistants)
panes. See also specific panes

working with, 7
paper feed for printing, 217
paper handling for fax documents, 225
paper size for printing, 210, 214, 216
paragraphs

indent markers, 191
spacing, 193

parental controls
for Dictionary, 185
logging activity with, 402
time limits, setting, 403
for user accounts, 401, 402-403

partitioning disks, 483, 533
passwords. See also Keychain

AutoFill with Safari, 250-251, 416-418
with FireVault, 409
hints, adding, 398
for Internet connections, 228
for logging out, 25
from login window, 397
for Mail, 269, 273
for Messages, 303
password, changing, Apple ID, 410-411
Recovery key, FileVault, 410-411
reset password, admin or user, 411
on shared computers, 3
in Simple Finder, 94
tips on creating, 410

Paste command, 46
pasting

Automator workflows, 517
formatting, 197
ruler, 189

path bar
for windows, 12

PDAs.
Bluetooth with, 428

networks with, 419
PDF files

Auto Save, in Preview, 162-163
documents as PDF files, saving, 219
downloading Acrobat Reader, 219
previewing, 162-163
Safari, viewing in, 255
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PDF files (continued)
Saving in, TextEdit, 200
signatures, adding, in Preview, 162-163
Spotlight searches, keywords for, 59
working with, 163

pen cursors, 130
People, Dashboard displaying, 168-169
permissions. See also file permissions

disk permissions, repairing, 455
file access permissions, 400
file permissions, 436
for screen sharing, 438-439

phones. See cell phones
Photo Album, Automator example for, 512
Photo Booth, 135, 325. See also Messages

animated GIF, creating, 309
capturing photos in, 345
effects, adding, 347
proof sheets, 345
videos

effects, 318
recording, 346

Photo Browser, 278
Photo Stream

iCloud, 356, 358, 364-365, 362-363
photographs.

e-mail, inserting in, 278
Messages buddy picture, changing, 309

Photoshop Preview, opening files in, 162
pictures. See images
Pictures folder, 30-31
Pipe Organ voice, 118
Places section, Sidebar, 18
Plain Text Encoding pop-up, 175
Plain Text files

documents as Plain Text files, saving, 201
TextEdit preferences, setting, 204

playlists. See iTunes
plug-and-play devices, 464
plug-ins

Automator with, 513, 520
compatible plug-ins, checking, 264
Safari, enabling in, 262-263

podcasts.
listening to, 340

pointing with mouse, 6
POP (Post Office Protocol), 271

pop-up menus, 8
in dialogs, 9
on toolbar, 19

pop-up windows, blocking, 264
portrait orientation printing, 215, 216
PostScript files, 211

PDF file, converting to, 162
PowerBook/MacBook

sleeping options, 111
wireless connections, 232

power failure restart options, 110-111
Power Nap, 110, 495
PowerPC, Rosetta, 533
power strips, 464
ppm (pages per minute), 206
PPoE (Point to Point Protocol over

Ethernet), 231
making connection with, 234

PPTP protocol, 442
preferences. See also Finder Preferences;

hardware; Messages; Safari; System
Preferences

Bluetooth preferences, setting, 431
Calendar preferences, changing, 373
Dictionary preferences, setting, 184-185
Dock preferences, setting, 88-89
iTunes preferences, setting, 343
Language & Region, 106-109
Mail, addressing, 276-277
Sidebar preferences, changing, 86-87
Spotlight preferences, customizing, 66
TextEdit preferences, setting, 204
for Time Machine, 494
VoiceOver preferences, setting, 126-127

presentation keyword for Spotlight, 59
Preview, 135, 162-163

iCloud, 364-365, 366-367
Preview column, Columns view, 39
Preview File Open command, 162
previewing

dialogs, area in, 9
Info window options, 53
printed documents, 218
print image, 216

Print command, 216-217
printer drivers, 207
printers. See also Bonjour; network printers

adding or removing, 208-209
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default settings, setting, 210
description of, 206
desktop printers, using, 217
IP (Internet Protocol)

for installing printers, 209
for sharing printers, 212-213

manually adding, 208-209
Network Sharing Services, 420
PostScript Printer Desc. (PPD) files, 211
sharing, 212-213, 420
Sharing Service, 420
specific settings, setting, 211

Printer Setup Utility, printer drivers in, 207
Printers folder, displaying printers in, 217
Printers & Scanners preferences, 210-211
printing, 205

Automator workflow, 519
basic print options, setting, 216-217
Calendar, 377
from Contacts, 149
cover pages, creating, 217, 221
e-mail messages, 291
help topics, 75
Page Setup options, 214-215
previewing printed documents, 218
queues, managing, 217, 220
reverse order printing, 217
saving print options, 225
to shared printers, 213
two print jobs with two printers, 215
web pages, 254

Print Queue utility, 217
privacy preference in Spotlight, 66-67
Private Browsing, 238
privileges for users and groups, 422
proof sheets in Photo Booth, 345
protocols, 271
proxies, 228
Public folder.

in Home folder, 30-31, 410, 436
publishing calendar, 378
pull-down menus, 8
Push button in dialogs, 9

Q
Quartz Extreme enhanced graphics, 102
Quartz Filters

Automator example workflow for, 512
for printed documents, 217

Quick Erase setting, 456
Quick Look

attachments, viewing, 286-287
toolbar button, 19
viewing files with, 40

QuickTime movies, 346
iMovie, 354
streaming options, 350-351

QuickTime Player, 135, 325
creating and editing movies, 352-353
full screen, 350-351
playing movies, 350-351

publish to YouTube, Vimeo, Flickr,
Facebook, and Mail, 352-353

quitting applications, 142
rotate movies, 350-351
sharing movies, 352-353

quoting text in e-mail, 284

R
radio. See also Internet Radio; iTunes

Internet Radio, 339
iTunes Radio, 338
podcasts, listening to, 340

raising characters, 192
read and write permissions

for moving/copying files, 47
for network users, 422
in Shared folder, 410, 436

read-only permissions
documents as read-only files, 200
for moving/copying files, 47
for network users, 422
in Public folder, 410, 436

Reading button, Safari, 236
using, 242-243

Reading List, Safari, 236
using, 242-243

Recent Folders list, 41
recently used items

applications, opening, 138
documents, opening, 175
numbering, changing, 100-101

recording
AppleScripts, 524
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recording (continued)
Automator actions, 520
video chats, 318

recovering. See restoring
Recovery key, FileVault, 410-411
Recovery HD mode, 532-534
Redo command, 45
redoing. See undoing/redoing
refresh rate, setting, 470
registration symbol, inserting, 198
reinstall OS X, 528, 534
reloading web pages, 238-239
Reminders.

accounts, 387
calendar, 382
creating, 383
iCloud, 358, 362-363, 364
lists, working with, 384-385
notification, adding, 386
Notification Center, 390-393
viewing, 384
window, 382
working with, 385

Remote App, 337
Remove Disc, sharing, 420-421
removable disks, 29

Info window, information in, 52-53
Rendezvous websites, adding, 248
repair

disks, 454
disk permissions, 455

replacing. See finding/replacing
resizing. See size/resizing
resolution

monitor resolution, setting, 470
of printers, 206

restarting, 26
forcing a restart, 462
from Login window, 3
with OS X, 112
power failure restart options, 110-111
in Target Disk Mode, 112
Time Machine backup for, 497

restoring
calendar, importing, 379
compressed files and folders, 450
deleted files and folders, 50-51

disk image, 505
e-mail, 290
master password, restoring, 410-411

Return key, 9
reverse order

fax documents, sending, 225
printing pages in, 217

RGB (Red, Green, Blue) colors, 474
right-alignment

of document text, 188
of tables, 194

right indent marker, 191
Rosetta, PowerPC, 533
routers, 228, 424
RTFD files, documents as, 174
RTF files

documents as, 174, 200
formatting text in, 188

rulers, showing/hiding, 189

S
Safari, 135

advanced preferences, setting, 261
alerts for nonsecure forms, 251
appearance (general) preferences, 

setting, 261
AutoFill preferences, setting, 250
bookmarks, 236

creating and deleting pages, 247-249
folder, creating, 248
organizing, 249
Spotlight searches, keywords for, 59
synching on multiple computers, 249
tabs, opening with, 240-241

Bookmarks Library, 247
deleting bookmarks in, 248-249
organizing bookmarks in, 249
renaming collection, 249

cache, emptying, 246
compressing/uncompressing disk

images, 259
Contacts to Favorites bar, adding, 248-

249
copying text from web page, 257
credit cars, AutoFill, 250-251
customizing window, 236
default browser, selecting, 266
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Safari (continued)
deleting

bookmarks, 248-249
History list entries, 246

different window, opening page in, 241
disk images, downloading, 259
downloading

files, downloading, 258-259
Downloads window, working with files

in, 258-259
encoding preferences, setting, 261
extensions, 260
Favorites bar, 236, 236, 247
font preference, setting, 261
forms, filling out, 250-251
full screen app, using, 139
general preferences, setting, 260
grammar-checking in, 251
help information in, 74
History list

clearing settings, 266
preferences, setting, 260
viewing, 246

Home page
changing, 237
going to, 238-239
preferences, setting, 260

HTML code, viewing, 256
iCloud, 358, 364-365, 366-367
navigating in, 238-239
nonworking web pages, 264
Notification Center, 390-393

from websites, 393
Notifications preferences, 265
opening web pages in, 238
PDF files, viewing, 255
pictures from web page, saving, 257
plug-ins, 262-263
pop-up windows, blocking, 264
printing web pages, 254
reloading pages, 238-239
resetting settings for, 266
saving

information in web page, 256-257
text of web page, 256

security & privacy preferences, 262-263
Shared Links, 236-237, 244

sharing, 244
Sidebar, 236, 242-244, 247-249
size of text, changing, 241
Smart Search field, 238-239, 252
SnapBack page, 253
spell-checking in, 251
starting application, 236
style sheet preferences, 261
synching bookmarks on computers, 249
tabs

opening web page with, 240-241
setting browsing options for, 240

Top Sites, 245, 260
viewing window, 236
Web Clip widgets, creating, 172

Safe boot, performing, 480
Safe Mode, 2
Save As dialog box, 200
saving. See also Safari

attachments, files in, 287
Automator workflow, 519
Bonjour chats, 305
e-mail, 292
Keychain, changes in, 415
print options, 225
Smart folders, copy of, 73
web page information, 256-257

scanning
documents, 222-223
images, 222-223

scanner information, viewing, 461
scheduling. See also Calendar

fax documents, 225
faxes, 225

screen savers, setting up, 103
screen sharing

permissions, setting, 438
using, 360, 439

screen shots, capturing, 161, 352-353
Script Editor, 524

Application Services with, 450
Script menus. See also AppleScripts

adding scripts to, 523
Automator workflow from, 520
displaying, 522
opening scripts from, 525
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scroll bars
changing action of, 100
options, changing, 100

search boxes
in Automator, 508-509
on toolbar, 19
for windows, 12

search engines, 252-253
Search For section, 18

Smart folders, using, 72-73
searching. See also Dictionary;

finding/replacing; Find window;
Spotlight

Automator workflows, 517
e-mail for text, 293
for hard to find information, 70
for help, 74-75
Internet, 252-253
metadata searches, 70
network, files on, 433
with VoiceOver, 125

secret folder hierarchy menu, 41
security. See also Keychain; passwords;

Safari
App Store downloads, 407
Internet security, 229
for logging out, 25
for switching between users, 24-25
security & privacy preferences, setting,

407-409
selecting

documents, text in, 176
icons, 10

Sepia effect, 347
servers. See also Mail

Find window searching, 68
OS X Server account, 268

Share button
Notification Center, 378-394

Shared folder in Home folder, 410, 436
Shared Links, Safari, 236-237, 244
Shared section, Sidebar, 18
sharing. See also network printers; Network

Sharing Service; screen sharing
buddies, screens with, 305
Home folder, sharing files in, 410, 436
Calendars, 378
Contacts, 146, 150-151

Messages screens, 305
Internet connections, 229
Network Sharing Services, 420-421
online services, 49, 450
printers, 212-213, 420
starting on shared computer, 2-3
widgets, 168
Windows, Mac files with, 360, 440
Windows computers, connecting from,

441
Sharing Preferences, 420
shortcuts. See aliases; keyboard shortcuts
Show All command on Spotlight menu, 60
showing/hiding. See also Dock

applications, 140
Dashboard, widgets on, 168
with Exposé, 22
file extensions, 81
List view, folders in, 36
Mailbox list, 289
rulers, 189
Sidebar and toolbars, 18-19, 86

Show Inspector, 52
Show Modem Status menu, 230
Show View Options command, 34
shutting down, 26

from Login window, 3
options, setting, 110-111

Sidebar
customizing, 86-87
networks, accessing, 433
preferences, changing, 86-87
Safari, 236, 242-244, 248-249
shared (AirDrop), displaying, 437
showing/hiding, 18, 19, 86
Smart folders, using, 72-73
tagging with, 42-43
using, 18
for windows, 12

sight impaired users, preferences, 120-123
signatures to e-mail, 280

adding, in Preview, 162-163
Simple Finder, 94
size/resizing. See also compressing/uncom-

pressing
files and folders arranged by size, 35
Find window searches by size, 69
font size, 188
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help text, 75
web page text, 241
windows, 12, 14-15

Ski Report, Dashboard displaying, 168-169
sleep mode, 26

faxes, turning off to receive, 226
from Login window, 3
setting sleep options, 110-111

slider in dialogs, 9
slideshows for Spotlight results, 65
Slow Keys, 120-123
Smart folders

changing search criteria for, 73
creating and editing, 72-73
saving copy of, 73
Sidebar, using in, 72-73

Smart Mailbox, creating, 297
Smart Magnify tool, Preview, 162-163
Smart Playlists, building, 332-333
smart searches with VoiceOver, 125
SMB/CIFS

file services, 440
sharing printers with, 212-213

smileys in instant messages, 312-313
smoothing fonts on screen, 473
SMS (short message service) text, sending,

304
SMTP (Simple Mail Transfer Protocol), 271
SnapBack page, 253
Snap to Grid setting, 35
software. See also hardware

automating updates, 447
compatibility, checking for, 480
downloading, 446
installing, 132-133, 446
removing hardware device software, 480
uninstalling, 50, 133, 446
updating, 446

Solid Colors Background, 102
sorting

by color labels, 42-43
e-mail messages, 289
Find window file results, 71
List view, files and folders in, 36-37
Spotlight results, 64
widgets, 171
sounds. See also alerts; VoiceOver

changing sound effects, 114
dates and times, announcing, 105
input options, setting, 115
MIDI devices, configuring, 478-479
output options, setting, 115
Spotlight searches, keywords for, 59

Spacebar with spring-loaded folders, 48
Spaces. See also Mission Control

customizing, 92-93
Dashboard preferences, changing, 169
grouping windows into, 23
multiple displays, 472-473

spacing
character spacing, changing, 192
line spacing, changing, 193

Speakable Commands window, 120
speaking voice. See also Alex; VoiceOver

document text, speaking, 185
for e-mail, 278
interface options, setting, 119

speech recognition, 120-123. See also Alex
Application Services with, 450
with Contacts, 146, 149
enabling, 117
for Sticky Notes, 165
using, 117

speed of printers, 206
spell and grammar checking, 173

adding words to dictionary, 182
for documents, 182-183
e-mail, 275
in Safari, 251
in Spotlight, 61

Spotlight, 57
backed-up items, recovering, 498-499
canceling search, 59
desktop icon, 5
e-mail, searching for, 293
filtering results, 62-63
finding information with, 58-59
grouping results, 64
help with, 76
keyboard shortcuts, setting, 66-67
keywords for searches, 59
metadata, finding information with, 59
preferences, setting, 66-67
privacy preferences, setting, 66-67
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Spotlight (continued)
sorting results, 64
viewing results in window, 60-61
windows, working with, 60-61
working with results, 65

Spotlight Search box, 76
spring-loaded folders

customizing, 80
using, 48

stacks on Dock, 21
starting. See also restarting

Automator, 510
Bonjour messaging, 305
CDs, changing start settings for, 113
DVDs, changing start settings for, 113
with Fast Startup Switch, 24
iTunes, 326
Mac for Windows, 486-487
Mac disk, starting from, 112
Messages, 300
power failure restart options, 110-111
Safe boot, performing, 480
specifying startup items, 404-405
stand-alone computer, 2

Startup commands, 405, 411
startup disk, 28-29

selecting, 112
Startup Disk Control Panel, 112
stationery for e-mail, 278
Stationery Pad in Info window, 52-53
status bar

in Safari, 236
for windows, 12

status menus
in Messages, 306-307
Internet, connecting to, 234

Sticky Keys, 120-123
Sticky Notes, 135

Application Services with, 450
creating, 165
Dashboard displaying, 168-169

Stocks, Dashboard displaying, 168-169
Stuffit Expander, 35, 133, 448
styles

deleting style favorites, 196-197
documents, applying to, 196-197
favorite styles, applying, 196-197

for fonts, 167
Safari style sheets, 261
toolbar styles, changing, 85

submenus, 8
subnet masks, 228
subscribing

to Calendar, 378-379
to Contacts, 151
to podcasts, 340

subscript characters, 192
summary

of Application Services, 450
of printer options, 217

superscript characters, 192
support for Mac, 530
surge protectors, 464
switching

between applications, 140-141
between Dock applications, 20
Fast User Switching, enabling, 406
between help libraries, 74
between users, 24-25
between windows, 14

symbols. See also copyrights; trademarks 
registration symbol, inserting, 198

synchronization. See also Yahoo!, iPhone,
iPad, iPod touch synchronization

of Contacts, 146
Safari bookmarks on multiple 

computers, 249
System Administrator. See Administrator
System folder, 28-29
System Preferences, 95. See also hardware;

monitors; QuickTime movies;
VoiceOver

Accessibility options, 120-123
App Store options, 446-447
Bluetooth options, 431
CDs & DVDs options, 113, 328
Date & Time options, 104-105
description of, 96-97
desktop backgrounds, changing, 102
Dictation & Speech options, 116-117
Displays options, 470-473
Dock options, 88-89
Energy Saver options, 110-111
General options, 100-101
iCloud options, 356-359
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Ink options, 130
international options, changing, 106-107
Internet Accounts options, 268
Internet preferences, list of, 96-97
Keyboard options, 467
Language & Region options, 106-107
locking/unlocking, 99
Misssion Control options, 92-93
Mouse, changing, 468
Network options, 429
network preferences, list of, 96-97
Notifications options, 390-391
overall preferences, list of, 96-97
Parental Controls options, 402-403
personal preferences, list of, 96
Printers & Scanners, 210-211, 212-213
Screen Savers, setting up, 103
Security & Privacy, 407-409
Sharing options, 420-423
sleeping options, setting, 110-111
Sound, controlling, 114-117
speaking voice, setting, 118-119
speech recognition options, 120-123
Spotlight searches, keywords for, 59
Startup disk, selecting, 112
Time Machine options, 494
Trackpad, 6, 469
Users & Groups options, 397-401
viewing, 98

System Information, viewing system infor-
mation with, 461

system recovery with Time Machine, 484
system requirements, OS X, 528 

T
tab bars in Safari, 236
tab bars in Finder

adding, 17
closing, 17
copying or moving with, 46-47
opening windows with, 17
parts of a window, 12
showing or hiding, 16
work with, 17

tables
cells, 194-195
documents, adding to, 194-195

merging cells in, 195
nesting tables, 195

tabs. See also Safari
in dialogs, 9
paragraph tabs, setting, 190

tab stops, setting, 190
tactile feel of keyboard, 467
Tags

arranging by, 33-34
assigning, 18, 42
deleting, 43
editing, 19, 42-43
Finder preferences, 80, 86-87
renaming, 43
searching with, 68-70
setting file information, 52-53
Sidebar, 18
sorting by, 43
tagging, 18, 42-43
untagging (removing), 42
viewing, 18, 33, 43

tagging files, 164, 200-201, 219, 256
Places section, Sidebar, 18
Take Video Snapshot button, 148
.tar files, opening, 448
Target Disk Mode, restarting computer, 112
TCP/IP, 438

for modems, 230
telephones. See cell phones
television podcasts, listening to, 340
text. See also documents; Mail

encoding, selecting, 260-261
in Safari, 236
substitution, preferences, 108-109

TextEdit, 135, 173. See also documents
Application Services with, 450
automatic opening documents in, 81
iCloud, 364-365, 366-367
opening documents, 141, 174-175
Page Setup options, 214-215
preferences, setting, 204
speaking text in, 185
for Web design, 202-203

text substitution, 108-109, 181
text wrap

changing, 191
TextEdit preferences, setting, 204
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thesaurus, 184
third-party applications. See also software

installing, 133
System Preferences, 97

threads, sorting e-mail by, 289
Time Capsule, 494, 497
Time Machine, 135, 493

entire computer system, recovering, 484
excluding items from backup, 496
Power Nap, using with, 110, 495
preferences, setting up, 494
previous version of Mac OS X, reverting

to, 484-501
recovering backed-up items, 498-499
restarting backup, 497
setting up, 494
starting manual back up, 495
system, recovering, 484-501
working with backup, 497

time management. See Calendar
times. See dates and times
time zones, setting, 104
Timer Coalescing, 459
title bars

aliases, creating, 91
for windows, 12

toolbars. See also Automator
adding icons to, 85
customizing, 84-85
deleting icons from, 85
Finder toolbar, customizing, 84-85
parts of, 19
rearranging icons on, 85
in Safari, 236
showing/hiding, 18, 19
styles for, 85
for windows, 12
working with, 7

Top Sites, Safari, 245
trackpad, 6

Trackpad preferences, 469
trademark symbols

documents, inserting in, 198
Translation, Dashboard displaying, 168-169
Trash, 10

empty Trash warning, turning on/off, 51,
81

files and folders in, 50

securely deleting files and folders, 51
software, uninstalling, 50, 446
uninstalling software with, 50, 446

transfer information
between Mac and PC, 457

trojan horses, preventing, 407
troubleshooting

Bonjour problems, 304
disk problems, 454
hardware problems, 480
Safe boot, performing, 480

turning on/off. See also Messages
Bonjour, 304
Dock hiding, 20
empty Trash warning, 51, 81
FireVault, 409
gestures, 130
keyboard shortcuts, 9
spring-loaded folders, 48

Twitter 
Application services, using, 450
Photo Booth, using with, 345-346

post a tweet, Notification Center, 394

set picture as profile picture, 345

setting up account, 268

Safari extension, 260-261
Shared Links, 236-237, 244

sharing, 49, 244

U
underlining

document text, 188
e-mail message text, 279
fonts, 167

Undo command, 45
undoing/redoing

Contacts, 149
documents, actions in, 180
file deletions, 51
in Finder, 45
ink recognizing, 130

Unicode for languages, 175
uninstalling

hardware, 465
OS X, 528
software, 50
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software update options, 446
Unit Converter, Dashboard display, 168-169
UNIX compressed files, opening, 448
unmounting networks, 56
updating

automating software updates, 447
from Boot Camp beta, 483
widgets, 169

up/down arrows in dialogs, 9
URLs (Uniform Resource Locators), 238

Application Services with, 450
home page, typing address for, 237

USB
FireVault protecting, 409

user accounts, 395, 396
access privileges, setting, 401
adding, 398
deleting, 399
Fast User Switching, enabling, 406
file permissions, setting, 400
parental controls, setting, 401, 402-403
short name for, 398

user & groups preferences, 96-97. See
accounts and user accounts.

user names for Internet connections, 228
Users folder, 28-31
Utilities folder, 505

V
Variable list on Automator window, 508-509
vCards, 147, 150-151

in attachments, 286
e-mail, including with, 280

verbosity preferences, setting, 126
video cameras, 303
videos. See also DVD Player; Messages;

Photo Booth; QuickTime movies;
QuickTime Player

animated GIF, exporting movie as, 347
Dashboard displaying, 168-169
documents, adding to, 199
iMovie, 354
playing with DVD Player, 348
Spotlight searches, keywords for, 59

View buttons on toolbar, 19
views and viewing. See also specific views

changing window views, 32-33

customizing views, 32
disks, viewing, 28-29
documents, viewing, 30-31
hardware settings, 466
Calendar window, 370
iTunes window, 327
System Preferences, 98

Vimeo
Photo Booth, using with, 345

QuickTime, 352-353

setting up account, 268

sharing, 49
viruses, preventing, 407
Virtual Network Computing (VNC), 438
visible files, searching for, 69
VoiceOver, 120

Braille, support for, 124, 127
commands, using, 128-129
description of, 124-125
hot spots, 125, 128
keys for, 125
preferences, setting, 126-127
searches and utility, 125

VO keys, 125
volume. See sounds
Volume desktop icon, 5
VPN (Virtual Private Network), 442
VLAN (Virtual Local Area Network), 443

W
Wacom for handwriting recognition, 178
waking up options, setting, 110-111
Watch Me Do action, 516
Weather, Dashboard displaying, 168-169
Web addresses. See URLs (Uniform

Resource Locators)
Web browsers, 235. See also Safari

default browser, selecting, 266
history of, 227
Mail, starting, 269

Web Clips widget, creating, 172
web pages. See also HomePage; RSS feeds;

Safari
copying text from, 257
different window, opening page in, 241
Image Capture, building with, 160
navigating, 238-239
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web pages (continued)
nonworking web pages, 264
printing, 254
reloading, 238-239
saving, 256
searching within, 252-253
size of text, changing, 241

websites, 235. See also HomePage; web
pages

for printer driver downloads, 207
Whois service, 444
widgets, 168. See also Dashboard
Wi-Fi connection. See AirPort; wireless 

connection
Wikipedia, 184
windows, 1

activating, 12-13
Columns view opening new windows, 39
Exposé, using, 22
Finder Preferences for customizing, 80
mouse, resizing with, 15
opening/closing, moving, 12-14
sizing/resizing, 12, 14-15
spaces, grouping windows into, 23
switching between, 14
TextEdit preferences, setting, 204
views, changing, 32-33

Windows Media
Boot Camp Assistant and, 481
with Mac for Windows, 488

Windows, operating syste. See also Mac for
Windows

connecting to, 440-441
outside network, connecting, 441
sharing with, 440
upgrading to Windows, 484

WinZip, opening files compressed by, 448
wireless connection, Wi-Fi, 228. See also

AirDrop; AirPort; Bluetooth
infrared technology, 233
sending files, 437
setting up connection, 232, 429

workflow. See Automator
World Clock, displaying, 168-169
worms, preventing, 407
write-only permissions for net users, 422

X
X-Ray effect, Photo Booth, 347

Y
Yahoo! Address Book,

importing and syncing, 147
creating an account, 150-151, 268

Yahoo! 
calendar account, 268, 370
instant message account, 302-303

setting up account, 268

Yelp, Maps, 158-159

YouTube, QuickTime, 352-353

Z
Zoom button, 12, 15
zooming in/out

with DVD Player, 349
in Preview, 163
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